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Important notices 

Intended use 
SpirHOMEter is an electrical medical device designed to perform 
pulmonary function tests. It is to be used by physicians or by 
trained personnel on a physician responsibility. 
Caution: Federal law restricts this device to sale by or on the 
order of a physician. 
This equipment has been conceived with the aim of providing an 
auxiliary instrument  allowing: 
• the formulation of lung pathology diagnosis; 
• important studies concerning human physiology; 
• the collection of important information in sport medicine. 
No responsibility attaches COSMED Srl for any accident 
happened after a wrong use of the device, such as: 
• use by non qualified people; 
• non respect of the device intended use; 
• non respect of the hereunder reported precautions and 

instructions. 

Warnings 
The device, the program algorithms and the presentation of 
measured data have been developed according to the 
specifications of ATS (American Thoracic Society) and ERS 
(European Respiratory Society). Other international references 
have been followed when these were not available. All 
bibliography references are reported in Appendix. 
The present handbook has been developed with respect of the 
European Medical Device Directive requirements which sort 
SpirHOMEter within Class II a. 
It is recommended to read carefully the following precautions 
before putting the device into operation. 
The precautions reported below are of fundamental importance to 
assure the safety of all COSMED equipment users. 
1. This user manual is to be considered as a part of the medical 

device and should always be kept on hand. 
2. Safety, measure accuracy and precision can be assured only: 
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 • using the accessories described in the manual or given 
with the device. Actually non recommended accessories can 
affect safety unfavourable. Before using non recommended 
accessories it is necessary to get in touch with the 
manufacturer; 

 • ordinary equipment maintenance, inspections, 
disinfection and cleaning are performed in the way and with 
the frequency described; 

 • any modification or fixing is carried out by qualified 
personnel; 

 • the environmental conditions and the electrical plants 
where the device operates are in compliance with the 
specifications of the manual and the present regulations 
concerning electrical plants. In particular grounding 
reliability and leakage current suppression can only be 
assured when the device three – wire receptacle is connected 
to a yellow - green return connected to earth ground. 
Attempting to defeat the proper connection of the ground 
wire is dangerous for users and equipment. 

3. Before powering the system, check the power cables and the 
plugs. Damaged electrical parts must be replaced 
immediately by authorised personnel. 

4. Cleaning residue, particulates, and other contaminates 
(including pieces of torn or broken components) in the 
breathing circuit pose a safety risk to the patient during 
testing procedures. Aspiration of contaminates can 
potentially be life-threatening. Use disposable anti-bacterial 
filters or disinfect each part in contact with the patient before 
each test. 

5. You must follow all the cleaning procedures in System 
Maintenance, and you must thoroughly inspect the 
components after cleaning and before each patient test. 

6. This device is not suitable for use in presence of flammable 
anaesthetics. It is not an AP nor an APG device (according to 
the EN 60 601-1 definitions). 

7. Keep the device away from heat and flame source, 
flammable or inflammable liquids or gases and explosive 
atmospheres. 

8. In accordance with their intended use SpirHOMEter is not to 
be handled together with other medical devices unless it is 
clearly declared by the manufacturer itself. 
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9. It is recommended to use a computer with electromagnetic 
compatibility CE marking and with low radiation emission 
displays. 

10. It is necessary to make the PC, connected to the  
SpirHOMEter, compliant with EN 60601-1 by means of an 
isolation transformer.  

11. Graphical symbols used in accordance to present 
specifications are described here below: 

 Equipment type B (EN60601-1) 

 Danger: high temperature 

 OFF 

 ON 

 Protective earth ground 

 Alternating current 
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Contraindication 

The physical strain to execute the respiratory manoeuvre is 
contraindicated in case of some symptoms or pathology. The 
following list is not complete and must be considered as a piece 
of mere information. 

Absolute contraindications 
• Post-operating state from thoracic surgery 
• Severe instability of the airways (such as a destructive 

bronchial emphysema) 
• Bronchial non-specific marked hypersensitivity 
• Serious problems for the gas exchange (total or partial 

respiratory insufficiency) 

Relative contraindications 
• spontaneous post-pneumothorax state 
• arterial-venous aneurysm 
• strong arterial hypertension 
• pregnancy with complications at the 3rd month. 
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Environmental condition of use 

COSMED units have been conceived for operating in medically 
utilised rooms without potential explosion hazards. 
The units should not be installed in vicinity of x-ray equipment, 
motors or transformers with high installed power rating since 
electric or magnetic interferences may falsify the result of 
measurements or make them impossible. Due to this the vicinity 
of power lines is to be avoided as well. 
Cosmed equipment are not AP not APG devices (according to 
EN 60601-1): they are not suitable for use in presence of 
flammable anaesthetic mixtures with air, oxygen or nitrogen 
protoxide. 
If not otherwise stated in the shipping documents, Cosmed 
equipment have been conceived for operating under normal 
environmental temperatures and conditions [IEC 601-1(1988)/EN 
60 601-1 (1990)]. 
• Temperature range 10°C (50°F) and 40°C (104°F). 
• Relative humidity range 20% to 80% 
• Atmospheric Pressure range 700 to 1060 mBar 
• Avoid to use it in presence of noxious fumes or dusty 

environment and near heat sources. 
• Do not place near heat sources. 
• Cardiopulmonary resuscitation emergency equipment 

accessible. 
• Adequate floor space to assure access to the patient during 

exercise testing. 
• Adequate ventilation in the room. 

Notice: if  accidentally droppings, exposure to heat source and 
excessive humidity may compromise the validity of the system, we 
recommend you a check or ask for a technical assistance. 
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Safety and conformity 

Safety 

IEC 601-1 (1988) /EN 60 601-1 (1990); 
Find reported below  the complete classification of the device: 
• Electrical internally powered equipment type B 
• Protection against water penetration: IP00, ordinary 

equipment unprotected against water penetration 
• Non sterile device 
• Device not suitable in the presence of flammable 

anaesthetics; 
• Continuous functioning equipment; 

EMC 

SpirHOMEter meets the EMC Directive 89/336 
EN 60601-1-2 
EN 55011 Class B (emission), IEC 1000-4-2, IEC 1000-4-3, IEC 
1000-4-4 

Quality Assurance 

UNI EN ISO 9001:2000 (Registration n° 387-A Cermet) 

Medical Device Directive (CE mark) 

MDD 93/42/EEC (Notified Body 0476). 
Class IIa 
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Keynotes 

Here are the keynotes used to make the manual easier to read. 

Typographic keynotes 
These are the typographic keynotes used in the manual. 

Style Description 

Bold indicates a control or a key to be pressed. 
 

“Italic” indicates a messages shown by the firmware. 

Graphic keynotes 
These are the graphic keynotes used in the manual. 

Illustration Description 

 shows the button to click in the software to 
activate the related feature. 
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Before starting 

Before operating the SpirHOMeter we strongly recommend to 
check the equipment and register you as a customer. 

Checking the packing contents 
SpirHOMEter and its software are in two different packaging, 
because it is necessary only one software to manage more units. 
The first purchase will be of two packages:one containing the 
software, the other one the SpirHOMEter. Make sure that the 
packing boxes contain the items listed below. In case of missing 
or damaged parts, please contact your nearest COSMED 
technical assistance. 

SpirHOMEter standard packaging 

Code  Qty Description 

C00486-01-05 1 SpirHOMEter unit 
 

C00033-01-05 1 Turbine 
 

A 662 100 001 1 Nose clips 
 

C00063-01-20 2 Conic mouthpiece 
 

C00066-01-10 1 Carrying case 
 

A 410 110 001 4 AAA battery 1,5 V 
 

C00067-02-94 1 Registration card 
 

C01999-02-DC 1 Conformity declaration 
 

C00065-02-91 1 Patient manual 

Kit software SpirHOMEter standard packaging 

Code  Qty Description 

C02053-02-35 1 PC software 
 

C00021-01-30 1 9 pin F adaptor 
 

C00674-01-12 1 Interface cable RS232 
 

C00067-02-94 1 Registration card 
 

C02046-02-91 1 User manual 
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Warranty registration 

Before using the system, please take a moment to fill in the 
registration form and the warranty and return them to COSMED, 
by doing this you are eligible to the customers assistance service. 
For further information, please refer to the enclosed registration 
and warranty form. If the form is not enclosed in the packaging, 
please contact directly COSMED. 

Register the product via software 

Together with the PC software, a registration software is 
supplied. With this software it is possible to fill in an electronic 
form with the customer information. 
1. To run the software, double click on the icon Registration or 

select Registration… from ? menu. 
2. Type the requested information and click Send… to send the 

form via e-mail to COSMED. 

How to contact COSMED 

For any information you may need, please contact the 
manufacturer directly at the following address: 
COSMED S.r.l. 
Via dei Piani di Monte Savello, 37 
P.O. Box n. 3 
00040 - Pavona di Albano 
Rome - ITALY 
Voice: +39 (06) 931.5492 
Fax: +39 (06) 931.4580 
email: customersupport@cosmed.it 
Internet: http: //www.cosmed.it 

Complain, feedback and suggestions 

If you have any complain, feedback information or suggestion, 
please inform us at complain@cosmed.it. 
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PC configuration required 

• Pentium 133 MHz. 
• Windows 95, 98, XP. 
• 16 Mb RAM . 
• 3.5 drive. 
• VGA, SVGA monitor. 
• Serial Port RS 232 available. 
• Any Mouse and Printer compatible with the MS Windows™ 

operative system. 
• PC conform to European Directive 89/336 EMC 
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Technical features 

Flowmeter Bidirectional digital turbine 
Flow Range: 0.03 - 20 l/s 
Volume Range: 12 l 
Accuracy: ± 3% or 50 ml 
Resistance @12 l/s: < 0.7 cmH2O/l/sec 
Memory: 120 tests 
Display: LCD 2 lines x 16 char 
Keyboard: 4 multi-function keys 
Serial port: RS232C 
Power supply: 4 AAA 1,5V batteries 
Dimensions: 175 x 35 x 35 mm 
Weight: 120g 
 
 
 



 

Measurements 



 

20 - SpirHOMEter User Manual 

Measured parameters 

Symbol UM Parameter 

FVC l Forced Expiratory Vital Capacity 
 

FEV1 l Forced Expiratory Volume in 1 sec 
 

FEV1/FVC% % FEV1 as a percentage of FVC 
 

PEF l/sec Peak Expiratory Flow 
 

FEV0.5 l Forced Expiratory Volume in 0.5 sec 
 

FEV6 l Forced Expiratory Volume in 6 sec 
 

FEV1/FEV6 % FEV1 as a percentage of FEV6 
 

FEV6/FVC% % FEV6 as a percentage of FVC 
 

Best FVC l Best Forced Expiratory Vital Capacity 
 

Best FEV1 l Best Forced Expiratory Volume in 1 sec 
 

Best PEF l/sec Best Peak Expiratory Flow 
 

Vmax25% l/sec Expiratory Flow @25% of the FVC 
 

Vmax50% l/sec Expiratory Flow @50% of the FVC 
 

Vmax75% l/sec Expiratory Flow @75% of the FVC 
 

FEF25-75% l/sec Mid-exp flow between 25-75%FVC 
 

FET100% sec Forced expiratory time 
 

FEV2 l Forced Expiratory Volume in 2 sec 
 

FEV3 l Forced Expiratory Volume in 3 sec 
 

FEV2/FVC% % FEV2 as a percentage of FVC 
 

FEV3/FVC% % FEV3 as a percentage of FVC 
 

FEV1/VC% % Tiffenau index 
 

FEF50-75% l/sec Mid-exp flow between 50-75%FVC 
 

FEF75-85% l/sec Mid-exp flow between 75-85%FVC 
 

FEF0.2-1.2% l/sec Mid-exp flow between 0.2 l - 1.2 l 
 

FiVC L Inspiratory Forced Vital Capacity 
 

FiF25-75% l/sec Forced mid-inspiratory flow 
 

FiV1 l/sec Forced Inspiratory Volume in 1 sec 
 

PIF l/sec Peak Inspiratory Flow 
 

VEXT ml Extrapolated Volume (back extrapolation) 
 

PEFT msec Time to PEF (10% - 90%) 
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Prepare the SpirHOMEter 

Install/replace batteries 
The devices is battery operating. It uses 4 manganese alkaline 
AAA-size 1,5V batteries. 
1. The on/off switch must be set to 0. 
2. Remove the battery compartment cover. 
3. Insert the batteries as indicated on the back side of the 

device. 
4. Close the battery compartment. 
It is suggested to replace the batteries only if you  have the new 
ones. The SpirHOMEter, without batteries, retains the stored data 
only few minutes. 

Note: If you don't use the SpirHOMEter for a long time, remove 
the batteries, being careful to save on the PC the tests in the unit 
memory. 

Install the turbine 
Remove the transparent wrapping and insert the turbine as shown 
in the following figure. Be sure to push the turbine up to touch 
the end of the holder. 
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Turn on the device 
Set the on/off switch to I. 

Note: If the switch is already set to I, but the display doesn't 
show anything, turn off and then turn on the device. The 
SpirHOMEter, if not used, turn off itself automatically after 
about one minute. 
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Set-up the SpirHOMEter 

The SpirHOMEter has controls for data transmission, archive 
deletion, setting date and time. In order to use these controls, you 
have to access a menu that, from now on, will be called Control 
menu. 

The keyboard 
The keyboard is made of the following keys: 

 Deletion 

 Transmission 

 Calibration 

 Configuration 
For the sake of ease, we shall refer to the SpirHOMEter keys 
with the numbers they represent on the keyboard: 0, 1, 2 and 3 
respectively. 

Access to Control Menu 
1. Hold the key 3 down and, at the same time, switch on the 

device by setting the on-off switch to I. 
2. Release the key 3, and the display panel will display a menu, 

different from that accessible by the patient. 
2.Calib 3.Config 

1.Trans 0.Cancel 

By pressing the respective keys it is possible to: 
0 delete all the data stored in the memory 
1 transmit stored data to the PC via RS-232 or via modem 
2 calibrate the flowmeter 
3 adjust the internal clock, configure the modem option and 

set up the patient data. 
Let us exhamine these functions in detail. 
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Delete stored data 
Before the SpirHOMEter is delivered to the patient, it must be 
reprogrammed to free up the memory, used during the last 
session. 
1. Access the control menu 
2. Press the key 0 (deletion). The following message will 

appear: 
Insert 

secret code 

3. Press in succession the keys 3, 1, 0, 2. 
At the end of this operation, the following message will appear 
on the display of the device: 

MEMORY EMPTY 

(Press any key) 

Transmit data to the PC 
This function is described in the chapter Database management. 

Calibrate the flowmeter 
This function is described in the chapter Calibration. 

Set-up date and time 
In order to set up the date and the time: 
1 Access the control menu 
2 Press the key 3 to enter in configuration 
3 Press the key 3 (date). 

Date      Time 

05/04/03   08:55 

4 Move into the fields dd/mm/aa – hh/mm, by means of the 
key 3 

5 Modify the time and/or the date with the key 2 (forward) or 1 
(backward) 

6 Confirm with the key 0. 
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Modem option 
With this option, the patient can send his/her tests via modem, 
directly from his/her own home. 
To configure the modem option (to store the phone number to be 
called): 
1 Access the control menu 
2 Press the key 3 to enter in configuration 
3 Press the key 1 (modem). 
4 To configure the transmission type (tone or pulse), press the 

key 1 (the setting switches between tone and pulse, the 
selected setting is the one in capital letters). 

5 To set up the telephone number, press the key 2 and then 
modify the ciphers by means of the keys 2 (increase) and 1 
(decrease), moving by means of the key 3. 

6 At the end of the entry, set up the character # 
7 Confirm with the key 0. 

Set-up patient data 
This function allows the user to set up the ID code and the best 
PEF of the patient. 
It is very important setting-up correctly the ID code of the 
patient: this code is used to refer the test data, transmitted to the 
PC through serial or modem connection, to the proper patient 
card. 
To set-up the patient data: 
1 Access the control menu 
2 Press the key 3 to enter in configuration 
3 Press the key 2 (paziente). 
4 To set up the best PEF press the key 1. To decrease or 

increase the displayed value, press respectively the key 1 or 
2. Confirm with the key 0. 

5 To set up the ID code of the patient, press the key 2 and then 
modify the ciphers by means of the keys 2 (increase) or 1 
(decrease), moving by means of the key 3. Confirm with the 
key 0. 
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Set-up the device 
When the SpirHOMEter is left without power for a relatively 
long period of time, when turned on it displays the following 
message: 

Setup 

the memory... 

Note: When this message appears, any data stored in the device 
are lost. Delete the stored data as already described. 
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Software installation 

Installing the software 
1. Select Run... from Windows Start menu. 
2. In the Command line box, type a:\install (assuming the disk 

is in drive A:). 
3. Click on OK (or press ENTER key). 
4. The program will load up a dialog box and ask for a 

directory where to be installed. 
5. When the installation is over, the program will advise you 

with a message indicating that the installation has been 
successfully completed, click on End. 

Notice: The software is copy-protected. Install the software from 
the original disk. 

Run the software 
1. In the Windows Start menu, open the Program Group in 

which the software was installed. 
2. Click the SpirHOMEter icon. 

PC port configuration 
The first time the software is used, it is necessary to configure the 
communication port with the PC (USB, COM1, COM2,…). 
For further details, see the chapter Database management. 
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Software main features 

Display 
The program may contain several windows. The active window 
is highlighted with a different colour of the caption. Some 
functions of the program are "active window" sensitive (Print, 
right key of the mouse). 

Tool bar 
Many of the functions that may be selected from the menu can be 
activated more rapidly by clicking with the mouse on the 
corresponding icon in the tool bar. 
Positioning the mouse cursor on one of the buttons of the toolbar 
(if the option Hints is enabled), the description of the 
corresponding function is shown in a label. 

Show/hide the toolbar 

Select Toolbar from Options menu in order to show or hide the 
toolbar. 

Dialog windows 
The typical operating environment of Microsoft Windows is the 
Dialog box. This window is provided with a series of fields in 
which input the information. 

Use of the keyboard 

• To move the cursor among fields, press the Tab key until 
you reach the desired field. 

• Press the Enter key to confirm the information input on the 
dialog box or press the Esc key to cancel changes. 

Use of the mouse 

• To move the cursor among fields, move the mouse on the 
desired field and left-click. 

• Click on the OK button with the Left button of the mouse to 
confirm the information input on the dialog box or click on 
Cancel button to cancel changes. 
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Scroll bars 
Some windows are provided with scroll bars that help to see data 
exceeding the window space available. 
• To move the scroll bar row by row click the scroll arrows at 

the end of the scroll bars 
• To move the scroll bar page by page click on the grey area at 

both  sides of the scroll fields 

On-line help 
COSMED Help is a complete on-line reference tool that  you can 
use at any time. Help is especially useful when you need 
information quickly or when the user manual is not available. 
Help contains a description of each command and dialog  box, 
and explains many procedures for accomplishing common tasks. 
To get the Help on line, press the F1 key. 

Software version 
To know the software version and the serial number of the 
software, select About SpirHOMEter… from Help menu. 
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Turbine calibration 

The SpirHOMEter is calibrated by COSMED. ATS recommends 
a daily calibration of the turbine. However if it is correctly 
maintained, turbine retains its precision for longer periods. We 
advice to calibrate the turbine daily to detect malfunctioning. 
The check must be carried out  measuring a known volume 
(calibration syringe) carrying out a FVC test, and verifying the 
measured value. If the difference between the predicted (real) and  
the measured value is greater than 3%, it is necessary to carry out 
the calibration procedure. 
In order to calibrate the turbine: 
1. Access the control menu. 
2. Press the key 2. The following message will appear. 

2.New      K=128 

1.Standard 0.Esc 

3. To cancel the operation, press the key 0. 
4. To restore the factory settings, press the key 1. 
5. To carry out a new calibration, connect the calibration 

syringe to the turbine and press the key 2. 
6. Perform 2 or 3 complete inspirations/expirations and wait for 

a message similar to the following one: 
Pred  Meas %Corr 

3.00  3.32  -9.7 

 Pred represents the real syringe volume, Meas the measured 
volume, %Corr the applied correction (in percent). 

7. Press a key. The following message will be displayed: 
2.Cancel   New 

1.Store   K=089 

 K indicates the new calibration factor. 
8. Press the key 1 if you want to store the new calibration 

factor, otherwise 2 to cancel the operation. 
The 3-liters calibration syringe can be purchased directly from 
COSMED (P/N C00243-01-06). 

Note: If a bacterial filter is used for the tests, do use it also 
during the turbine calibration. 
 



 

Database 
Management 
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Settings 

The software allows to configure some options selecting 
Configure from the Option  menu. 

 

Graphs 

All the graphs visualised and/or printed can be customised in 
colours and appearance. 
1. Select the desired colours of the curves (5 curves max can be 

overlapped on the same graph). 
2. Enable or disable the Grid option. 
3. Enable or disable the Show Info Test option. 

Serial port 

You must select the serial port RS 232 that will be used to 
connect the SpirHOMEter with the PC. 
To select the serial port, click on the proper COM button (the 
selected port must be different from the mouse one). 
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Units of measurements 

It is possible to configure the units of measurements, weight and 
height, for printing and viewing. 
To select the units of measurement click on cm/Kg or in/lb 
according to the desired format. 

Using extra fields  

The Patient’s database is organised in 3 different cards (Patient 
card, Visit Card and Test card.) where it is possible to store the 
information about patients and visits. 
Besides the standard information, it is possible to customise some 
fields (user free fields), entering and labelling measurements 
coming from other devices. 
The  customisable free fields are: 
• 3 fields in the Patient Card (Patient’s information) 
• 3 fields in the Visit Card (information about the visits) 
• 3 fields (2 numeric) in the Test card  information about Test) 

Customise the fields 

In the group User free fields type the desired text in the 9 fields 
available. 
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Patient's database 

The Patients database consists of a Patient Card, a Visit Card and 
a Test Card in which are listed all tests performed by the patient. 
Select Archive Navigator from the File menu  or press the 
button by side. 

 

Patient Card 

It collects all the information of a patient (first name, last name, 
date of birth) which remain the same for each visit. For each 
patient there is only one Patient Card, which is created the first 
time the Patient performs a test.  
To move within the database use the following buttons: 

 Move to the first patient in the archive 

 Move to the previous patient in the archive 

 Move to the next patient in the archive 

 Move to the last patient in the archive 

 Find a patient in the archive 

 Enter a new patient in the archive 

 Delete current patient from the archive 

 Edit the current patient card 

VVV 
Note: after having 
deleted a record 
(patient, visit or 
test), it is 
recommended to 
reorganize the 
archive in order to 
free disk space. 
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Visit Card 

It collects all information relative to the visit (diagnosis, visit 
description...) and to the patient information subject to change 
between one visit and another (height, weight, smoke). Each 
patient can be related to several Visit Cards provided they have 
been created in different days. Before carrying out any 
spirometric test it is necessary to create a new Visit Card or to 
open the today’s Visit Card.  
To move within the database use the following buttons: 

 Move to the first visit in the archive 

 Move to the previous visit in the archive 

 Move to the next visit in the archive 

 Move to the last visit in the archive 

 Find a visit in the archive 

 Enter a new visit card in the archive 

 Delete current visit card from the archive 

 Edit the current visit card 

Test Card 

It contains all the information about the test. 
To move within the database use the following buttons: 

 Delete current test from the archive. 

 Edit the current test 

Import/export a Tests card 
This function allows to import /export a test card with the 
respective visit and patient card. 
1. Select the patient. 
2. Choose the tests to be exported and press the key by side. All 

data will be imported/exported in the XPO file format 
(Cosmed proprietary). 

Diagnosis Database 
The program allows to manage a diagnosis database, whose 
records are composed by a diagnosis ID code and a string of text. 
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The report of the visits can be done either by typing the desired 
text in the field “Diagnosis” of the Visit Card or, more quickly, 
retrieving from the diagnosis database the desired one. 
If you want to insert, modify or delete a diagnosis from the 
database select Database Diagnosis... from the File menu. 
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Transmit data to the PC 

Before starting any analysis you must upload the data from the 
spirometer via the serial port. This operation is made up of the 
two following steps: 
1. Transmit data 
2. Link the test to a patient in the archive 

Transmit data 
1. Link up the spirometer to the PC with the RS232 cable 

supplied. 
2. Select Receive from the Test menu 

 
3. Access the control menu 
4. Press the key 1 to enter data transmission. 
5. Press another time the key 1 to select the transmission 

towards PC. 
6. Confirm pressing the Receive button on PC. 
7. Start data transmission from the spirometer by pressing any 

key. 
A solid bar on the PC display will highlight the state of data 
acquisition from the SpirHOMEter. 

Note: Be sure that the program is correctly configured to acquire 
data through the serial port (COM1 or COM2) as previously 
described. 
At the end of the data transmission, if reception has taken place 
correctly, the program will open a window to link the tests to the 
patient (see later). The SpirHOMEter display will show the 
following message: 

Check  the 

data rec’d 
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Link the test to a patient in the archive 
The data received from the spirometer are held in temporary 
memory. These tests must then be stored within the patient 
database by linking each test to the corresponding patient. 
1. Select Link from the Test menu. 

 
2. Select the test you want to link in the top area of the window. 

 Move to the first test to link 

 Move to the previous test to link 

 Move to the next test to link 

 Move to the last test to link 

 Delete current test 

 View a preview of the report 
3. Select the correspondent Patient in the bottom area of the 

window. 

 Find a patient in the archive by the Archive Navigator 
Id Find a patient in the archive with the same ID Code of 

the current test to link. 
Link Link the current test to the current patient. 
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Archive maintenance 

The software allows to manage files selecting Archive from the 
File menu. 
It is advisable to perform the archive reorganisation every month, 
in order to free space on the hard disk and/or to correct possible 
errors present within the database. 
It is possible also that your have no more hard disk space. So, 
you have to delete all the data. In this case, it is useful to perform 
the initialising. 

Reorganise the archive 
1. Select Reorganize archive from the File menu. 
2. Wait for the end of the operation before performing any 

other function. 

Delete the archive 
1. Select Initialize Archive from the File menu. 
2. Wait for the end of the operation before performing any 

other function. 

Backup and restore 
It is strongly recommended to backup files, a warning message 
will be displayed monthly. This function allows the user to 
restore the data if the PC or the HD will not work anymore. 

Backup 

1. Select Backup archive from the File menu. 

 
2. Selecting the destination path with the Browse key or press 

New to create a new directory. Press OK to confirm. 
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3. In the dialog box it will appear an estimate of the number of 
floppy you need in order to back up the archives. Press OK. 

Restore 

1. Select Restore archive from the File menu. 

 
2. On the Restore dialog box specify the drive source and press 

OK, a dialog box will appear indicating all data of the 
backup processed. 

 
 
 
 



 

Spirometry 
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Setting spirometry options 

The software allows to configure some options selecting 
Configure from the Option  menu. 

Spirometry 

 

Automatic Interpretation 

The SpirHOMEter has the function of interpreting each test 
performed by a patient visualising an automatic diagnosis. The 
algorithm has been calculated basing on “Lung Function Testing: 
selection of reference values and interpretative strategies, 
A.R.R.D. 144/ 1991:1202-1218”. The automatic diagnosis is 
calculated at the end of the FVC if: 
• the automatic diagnosis option is enabled. 
• the patient’s anthropometric data allow the calculation of the 

LLN (Lower Limit of Normal range). 
• at least one FVC test has been performed. 
To enable/disable the automatic diagnosis: 
1. Click on Enable Automatic Interpretation. 
2. Select the LLN (Lower Limit of Normal Range) criteria 

among the ATS (LLN=Pred-0.674*SD), ERS (LLN=Pred-
1.647*SD) or 80%Pred (LLN=Pred*0.8) specifications. 
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Quality control 

The SpirHOMEter allows a quality  test control. The calculation 
has been carried out referring to “Spirometry in the Lung Health 
Study: Methods and Quality Control, A.R.R.D. 1991; 143:1215-
1223”. The messages concerning the quality control are shown at 
the end of the test. 
To enable/disable the quality control, click on Enable Quality 
Control checkbox. 

Parameters manager 

 
The program allows to calculate a huge number of parameters; it 
is advisable, in order to simplify the analysis of the results, to 
view, to print and to sort the desired parameters only. Select the 
menu item Options/Parameters... 
View 
Move the parameters to view into the Selected parameters list. 
Print 
Move the parameters to print into the Selected parameters list. 
Sort 
Drag the parameter up or down with the mouse. 
Customise 
Add, modify and delete custom parameters. 
If it is necessary to restore the default parameters press the button 
in the left corner of the window to initialise the parameters 
database. 
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Predicted values manager 

 
The program contains a preset of predicted equations, but the 
user is allowed to customise its own predicted sets. Select 
Predicteds... from Options menu. 
The window is divided into two forms: Predicteds set and 
Formula definition. 

Predicteds set 

This form allows the user to manage the set of predicteds. The 
following information define a set: 
Name: identifies the set and cannot be duplicated; 
Description: free field; 
Age: the adult predicteds start since this age. 
To enter a new set of predicteds click on the New button. The 
field Name must be filled and must be unique. To stop without 
saving click on the Cancel button. To save the set, click on the 
Save button. 
To delete a set of predicteds click on the Delete button. If a set is 
deleted, also the associated formulae are deleted. 
It is possible to generate a new set of predicteds with the same 
attributes and the same formulae of the selected one. To do this 
click on the Copy... button and specify a new Name. 
To import a set of predicteds click on the Import... button and 
select a file of Predicteds files type. 
To export a set of predicteds click on the Export... button. 
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In the list Set current predicteds choose the current predicteds 
for printing and viewing. 

Set the current predicted 

The SpirHOMEter  allows to calculate the predicted values 
according to the following configurable sets: 

Adults Paediatrics 

ERS 93 Zapletal 
Knudson83 Knudson83 
ITS white ITS white 
ITS black ITS black 
LAM LAM 
MC Barcelona MC Barcelona 
Nhanes III Nhanes III 
Select the desired choice in the group Predicted. 

Formula definition 

 
This form allows the user to manage the formulae associated to a 
set of predicteds. 
Select the set of predicteds from the list Predicteds set. 
To insert a new parameter click on the New... button. 
The parameter formulae can be: 
• calculated according to the predicteds in the list Use the 

predicteds formulae; 
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• customised by the user with the option ...or the customised 
formulae. 

The Delete button deletes the selected parameter. 
The Copy button stores the selected parameter in memory. 
The Paste button inserts a new parameter from the one copied. If 
the name is not unique, the user is asked whether to specify a 
new name or to replace the existing parameter. 

Page set-up 

 
Select Page Setup... from the File menu. 
Header All the printouts carried out by the 

program are preceded by 3 rows of 
customisable header (usually they contain 
the name and the address of the Hospital 
using the spirometer). 

Data Patient and visit information are printed 
below the header. These data are reported 
on 3 columns and 5 rows. the user may 
configure the disposition, change and 
eventually cancel the fields, as he prefers. 

Margins Configures the print margins from the 
borders of the paper. The unit of measure 
is decided in Units of measurements. 

Footer Configures information at the bottom of 
the page. 
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Printed file name Defines the automatic name to be 
asssigned to the pdf file, if the report will 
be printed in this format. 

 
 In the example it has been set to create a 

filename composed by <date of the test> 
followed by <last name> and <first 
name>. 
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Spirometry tests 

Tips for correct use of the device 
Before the SpirHOMEter is delivered to the patient, we would 
advise that he/she receive a short course in use of the instrument 
and correct performance of the FVC test. 
In order to reach a clearer diagnosis and/or check the 
effectiveness of the treatment being administered, it is always 
advisable to record the severity of the symptom before the test, 
by pressing the reative keys 

Keyboard 
For the sake of ease, we shall refer to the SpirHOMEter keys 
with the numbers they represent on the keyboard: 

 Key 0. 

 Key 1. 

 Key 2. 

 Key 3. 

Drugs 
In order to analyze the state of the lung function also as a 
function of the treatment being received, it is possible to record 
the time at which the drug is taken. The SpirHOMEter records 
the date and the time at which one or more drugs (up to a 
maximum of 4) are taken. 
After switching on, the date and the time appear on the display 
panel, followed by this message: 

Do you want to 

enter drugs ? 

Press 0 for NO, press 1, 2 or 3 for YES. 
If YES, the device scrolls through the list of drugs to be taken. 

Drug A? 

 

VVV 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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Press 0 to indicate that the drug was not taken, otherwise press 1, 
2 or 3 to confirm. 
When the stage has been completed, the following message is 
displayed: 

Carry out 

test ? 

Press 0 to terminate the session, press 1, 2 or 3 to perform the 
test. 

Recording the severity of symptoms 
If the previous question has been answered affirmatively, the list 
of symptoms appears. The first is COUGH 

Cough ? 

 

Give the severity of the symptom (which will be recorded) by 
pressing 0 (absent), 1 (slight), 2 (medium), 3 (severe). 
Immediately after this, the symptoms DYSPNEA, MUCUS and 
WHEEZING will appear in order. Repeat the operations 
described for COUGH. 
When this phase has been completed, the following message will 
appears: 

Carry out 
test no.1 

Performing the test 
The Forced Vital Capacity (FVC) test can also be performed by 
taking a few normal breaths before step 4 (breathing in fully). 
For hygienic reasons, we strongly recommend the use of a 
bacterial filter. 
1. Fit the mouthpiece or the bacterial filter to the device 
2. Apply the noseclip 
3. Take the mouthpiece tightly between lips and breathe 

normally 
4. Breathe in fully 
5. Breathe out as quickly and long as possible 
6. At the end of the test some of the values obtained will appear 

on the display. 



 

52 - SpirHOMEter User Manual 

When the first test is complete, carry out the second, and then a 
third if the device requires it. 

Note: If the tests are not carried out correctly, the following 
error message will appear, and in this case the test session must 
be repeated. 

Test finished 

incorrectly 
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Viewing results 

All the visualisation functions refer to the test carried out by the 
Current Patient, whose name is indicated on the left-side of the 
status bar. 
To view tests results: 
1. Select  the Patients from the File menu 
2. Select the patient corresponding to the test you want to view. 
3. Select in the list box of the tests up to 5 tests of the kind 

(FVC, VC/IVC, or MVV) and press OK. 
To switch between graph and or data use the following buttons 
on the toolbar: 

 view  Flow Volume graph (F5) 

 view Volume Time graph (F6) 

 view data of the test (F7) 
If you need more than one visualisation meantime use the New 
Window function from the Window menu. 
If you need to display a list of visits: 
• Select Visits list... from the File menu. 
• Type the name of the Company and/or the time interval 

desired or simply confirm for the complete list. 

Tests of the current patient 

If a current patient has been selected you can quickly view his 
tests selecting Test current patient... from the View menu. 

Delete a test 

1. Select Patients  from the File menu  or press the button by 
side. 

2. Select the test that you want to eliminate from the list of the 
tests referred to the Current Patient and press Delete. 
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View a trend 
It is possible to analize the trend of measured parameters (FVC, 
FEV1, etc.) graphing the values, with reference to the symptoms 
and to the drugs taken. 
1. Select Trend... from View menu. 
2. It will be open a window in which are displayed all the tests 

linked to the current patient.Select the test you want view the 
trend, following the instructions on the window. 

 
3. In the lower part of the window, select the parameters to 

graph. For each trend graph, you can choose if it will be 
graphed a measured parameter and its predicted value or two 
different measured parameters. 

4. Press OK to confirm. 
A window will appear, divided into two sections: in the upper 
section you can see the measured parameters of all the tests, in 
the lower part, the trend graphs. On the graphs will be pointed 
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out when the patient had taken the drugs; below the graphs, for 
each time, it is shown the severity of the symptoms. 

 
You can choose to view, in the lower part of the window, the 
trend graphs or the measured values, from the View menu. 
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Printing results 

You can print out in three different ways: 
• printing the Report 
• printing the Active Window 

Printing Reports 
To print a report of the current visit, select Print report… from 
File menu. In the dialog box, select the visit you want to print the 
report. 
The software will choose automatically the best performed test (if 
more than 1 test was performed). 
• Selecting the option One page (no ATS) the report will 

contain, on one page, the F/V and V/t graphs of the best test, 
overlapped on the FVC Post, the patient data, the notes, the 
diagnosis and the test results. 

• Otherwise the report will contain two pages, the first with 
the patient data, the graphs and the diagnosis, and the second 
one with the measured parameters, according to the ATS 
recommendations. 

Select the desired options: 
FVC graph Prints the F/V and V/t curves for the best 

FVC test. 
One page (no ATS) Prints data and graphs on the first page. 
Preview Views a report preview on the screen. 

Printing the active window 
This active window printout function is only enabled when the 
active window (title bar highlighted) is one of the following 
objects: 
• Any kind of Graph. 
• Numeric data 
• List of visit 
To print the active window select Print Active window from 
File menu. 
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Printing a series of reports 
Sometimes it is useful to printout automatically a series of reports 
(all tests carried out with the employees, all tests carried out in 
the today's session). 
To print out proceed as follows: 
1. Select Visit List from the File menu 
2. Set the criteria of the visits to be added in the list (from, 

to,...) 
3. Select Print Report  from the File menu. 

Electronic reports (*.pdf) 
If an Adobe PDF writer “Printer Driver” is installed and set as 
the default printer, it is possible to store the printout report 
automatically in any location of the HD or eventually LAN paths 
according to a customizable filename format. 
It is possible to define the created filename format selecting 
File/Page Set up... (see Page set-up). 

Export data 
With this function you can export the test data in 4 different 
formats: 
• *.txt (ASCII) 
• *.xls (Microsoft Excel) 
• *.wk1 (Lotus 123) 
• *.xpo (Cosmed) 

Export a test 

1. Select Export tests from the File menu. 
2. Select the test to export from the list box and press OK. 
3. Type the name and the format of the file in the dialog Save 

as. If  the ASCII format is selected, the Text button in the 
dialog box Save as allows you to configure the separators for 
character based files.  

 With the *.xpo Cosmed file format it is possible to import 
data from another Quark archive. Press OK to confirm. 

4. Select the folder for the export and type the file name. Press 
OK to confirm. A status bar will show the file creation. 
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System maintenance 

All service operations which are not specified in this user manual 
should be performed by qualified personnel in accordance with 
the service handbook (to be required to the manufacturer). 
All materials used in the construction of the SpirHOMEter are 
non toxic and pose no safety risk to the patient or operator. 
Prior to the device cleaning, disinfection and inspection it is 
necessary to switch off the device and to disconnect adapters 
from the supply mains. 
In order to guarantee the highest accuracy of measurements we 
recommend you to disinfect the turbine periodically. 
Use disposable anti-bacterial filters or disinfect each part in 
contact with the patient before each test. 

Cleaning and disinfection 
Cleaning and disinfecting instructions are of fundamental 
importance to control infections and assure patient safety. In fact 
aspiration of residue, particles and contaminated agents are life – 
threatening. 
In this handbook we strongly recommend you to follow the rules 
worked out by ATS and ERS (see: ”Lung Volume Equipment 
and Infection Control” – ERS/ATS WORKSHOP REPORT 
SERIES, European Respiratory Journal 1997; 10: 1928 – 1932), 
which are summarised as follows: 
• Accessible internal as well as external surfaces of equipment 

exposed to expired gas should be washed and disinfected 
prior to testing of subsequent patients. 

• Liquid disinfection can be used if the equipment is well 
cleaned first (no droplets of saliva/sputum remain). 

• Disposable gloves should be worn when handling 
mouthpieces, when cleaning equipment exposed to saliva or 
sputum and especially when drawing blood. 

• Laboratory staff should wash hands prior to testing of each 
patient. 

• Adopt particular precautions when testing patients with 
recognised high – risk communicable diseases (e.g. 
tuberculosis, multidrug – resistant staphylococcus). In these 
cases, the clinical need for such testing should justify the 
risks. 
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During the disinfection: 
• do not use alcohol or other liquids containing gluteraldehyde 

on the exterior surfaces of the equipment. Actually they can 
damage polycarbonates plastics and may produce unhealthy 
substances. 

• do not use abrasive powders or glass cleaners containing 
alcohol or ammonia on the plexiglas components of the 
equipment 

• do not steam autoclave any parts of the equipment unless it 
is clearly specified. 

• do not immerse the optoelectronic reader. 

Preparing the disinfecting solution 

The following recommendations are retrieved from: 
APIC (Association for Professionals in Infection Control and 
Epidemiology, Inc.): APIC Guidelines for Selection and Use of 
Disinfectants; William A. Rutala, PhD, MPH, CIC. American 
Journal of Infection Control, vol.24, N.4, pp. 313-342, August 
1996 - http://www.apic.org/pdf/gddisinf.pdf 
As disinfecting solution it is suggested: 
• Sodium hypochlorite 0.5% (5000 ppm) prepared fresh for 

use within 24 hours. 
• Sodium hypochlorite 1% (10000 ppm) prepared fresh for use 

within 30 days. 
The first solution can be easily prepared by adding 1 part 
household bleach (sodium hypochlorite 5.25%) to 9 parts water, 
the second one by adding 1 part household bleach to 4 parts 
water. 

Cleaning the turbine flowmeter 

It is necessary to disinfect periodically the turbine for sanitary 
measures or/and for the correct device function. 
1. Take out the turbine. 
2. Dip it in a disinfectant solution (non alcoholic based) for 

about 20 minutes. 
3. Rinse the turbine in a vessel, filled of clean water, shaking 

gently to remove the disinfectant (do not clean the turbine by 
putting it under running water!). 

4. Let it dry to air. 

VVV 
Warning: Do not 
use alcoholic 
solutions for the 
turbine, 
otherwise there 
can be damages 
to the plastic 
material. 
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5. After cleaning the turbine, check if the turbine propeller 
rotates freely even with a low speed air flow. 

6. Connect the turbine to the reader. 

Precautions during the cleaning of the turbine 

1. Do not expose the turbine to high heat and do not put it 
under running water. 

2. Do not ever dip the optoelectronic reader in any kind of 
solution, the liquid infiltration would damage the internal 
circuit. 

3. Do not use alcoholic solutions to clean the turbine. 

Suggested disinfection solutions 

Helipur H Plus Braun Melsungen AG 
Gigasept FF Schulke & Mayr GmbH 
Dismozon pur Bode Chemie GmbH 
TETA-S Fresenius AG 
CIDEX Johnson & Johnson 

Inspections 
The equipment requires easy inspections to be carried out in 
order to assure a proper electrical and mechanical safety level in 
the years. 
These inspections are highly recommended after a rough use of 
the equipment or after a period of storage in unfavourable 
environmental conditions. 
Referring to the electrical safety, it is important to check the 
conditions of insulation materials of cables, plugs and any other 
visible part by means of simple inspection, when the equipment 
is switched off and disconnected from the supply mains. 
Extract the turbine from the unit and verify, by inspection, that 
the turbine axis fits correctly its seats and the blade is strongly 
fastened on the axis itself (it can be useful to shake slightly the 
turbine in order to note any anomalous movement). 
Check if there are any torn or broken components in the 
breathing circuits: remember that they can create safety risk to 
patients during tests. 
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Replace the batteries 
Replace the batteries when the following message appears: 

LOW 

BATTERIES 

The SpirHOMEter uses 4 AAA-size 1,5 Volt vatteries. 
1. Check that you have the new batteries ready. 
2. The on-off switch must be set to 0. 
3. Remove the cover of the battery compartment. 
4. Remove the old batteries. 
5. Insert the new ones as indicated on the back of the device. 
6. Close the battery compartment by sliding the cover along the 

slots. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VVV 
Note: Do not 
replace the 
battery if you 
don’t have the 
new ones 
ready. If the 
SpirHOMEter is 
left without 
batteries, it 
retains stored 
data only for 
few minutes. 
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Service - Warranty 

Warranty and limitation of liability 
COSMED provides a one (1) year limited warranty from the date 
of the original sale of COSMED products. All COSMED 
products are guaranteed to be free from defect upon shipment. 
COSMED’s liability for products covered by this warranty is 
limited exclusively to replacement, repair, or issuance of a credit 
for the cost of a defective product, at the sole discretion of 
COSMED.  COSMED shall not be liable under the foregoing 
warranty unless (i) COSMED is promptly notified in writing by 
Buyer upon discovery of defect; (ii) the defective product is 
returned to COSMED, transportation charges prepaid by Buyer, 
(iii) the defective product is received by COSMED no later than 
four weeks after the last day of the one (1) year limited warranty 
period; and (iv) COSMED’s examination of the defective product 
establishes, to COSMED’s exclusive satisfaction, that such defect 
was not caused by misuse, neglect, improper installation, 
unauthorised repair or alteration, or accident.  If the product is 
manufactured by a third-party, COSMED shall make available 
for the Buyer’s benefit only those warranties which COSMED 
has received from the third-party manufacturer(s). COSMED 
hereby specifically disclaims any and all warranties and/or 
liabilities arising from defect(s) and/or damage(s) to and/or 
caused by products manufactured by third-party manufacturers.  
Buyer must obtain written authorisation from COSMED prior to 
the repair or alteration of COSMED products(s).  Failure of 
Buyer to obtain such written authorisation shall void this 
warranty. 
COSMED hereby specifically disclaims any and all other 
warranties of any kind, whether express or implied, in fact or by 
law, including, but without limitation, any and all warranties of 
merchantability and/or fitness for a particular purpose. 
COSMED shall not be liable for special, indirect and/or 
consequential damages, nor for damages of any kind arising from 
the use of any COSMED’s products, whether said products are 
used alone or in combination with other products or substances.  
Determination of the suitability of any of COSMED’s product(s) 
furnished hereunder for the use contemplated by Buyer is the sole 
risk and responsibility of Buyer, and COSMED has no 
responsibility in connection therewith. Buyer assumes all risks 



 

 Chapter 8 - Appendix - 67 

and liabilities for loss, damage or injury to persons or property of 
Buyer or others arising out of the use or possession of 
COSMED’s products. 
The limited warranty as herein above set forth shall not be 
enlarged, diminished, modified or affected by, and no obligation 
or liability shall arise or grow out of, the renderings of technical 
advice or service by COSMED, its agents or employees in 
connection with Buyer’s order or use of the product(s) furnished 
hereunder. 

Return goods policy for warranty or non warranty repair 
Goods shipped to COSMED for repair are subject to the 
following conditions: 
1. Goods may only be returned after your receipt of a Service 

Return Number (SRN) from COSMED S.r.l. 
2. Place your SRN report and Packing List outside the package. 
3. Goods returned must be shipped with freight and insurance 

charges prepaid. Collect shipments will not be accepted. 
4. The following list of goods are not eligible for return unless 

proven defective. 
- Special order items 
- Expendable products 
- Goods held over 30 days from COSMED’s invoice date. 
- Used goods not in original shipping containers. 
- Goods which have been altered or abused in any way. 

5. The following parts are not covered by warranty: 
- consumables 
- fragile glass or plastic parts 
- rechargeable batteries 
- damages due to use of the device not conforming to the 
indication reported in this manual  

Repair Service Policy 
Goods returned to seller for Non-Warranty repair will be subject 
to conditions 1, 2, 3, 4. 
The returned goods need to re-enter COSMED together with the 
customs documents (Pro-forma Invoice and Customs Paper) as 
requested by the Italian law. 
• The shipment has to be qualified as a Temporary Export. 
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• All the goods returned to COSMED without the customs 
papers will not be accepted. 

For European Community members: 
Pro-Forma invoice complete with: 
• Number 
• Description of the goods 
• Quantity 
• Serial Number 
• Value in € 
• Number of parcel 
• Gross weight 
• Net weight 
• Reason for resent (i.e. Resent for repair) 
In case you should send the system for repair please contact the 
nearest service centre or contact COSMED at the following 
address: 
COSMED S.r.l. 
Via dei Piani di Monte Savello 37 
P.O. Box 3 
00040 Pavona di Albano - Rome, Italy 
tel. +39 (06) 9315492 
fax +39 (06) 9314580 
E-mail: customersupport@cosmed.it 
For USA customers only please contact: 
COSMED USA Inc 
2758 North Paulina 
Chicago IL 60614 USA 
Phone: +1 (773) 528-8113 
Fax: +1 (773) 528-8116 
email: usa.sales@cosmed.it 
To ensure that you receive efficient technical assistance, please 
specify as precisely as possible the nature of the problem as it is 
specified on the assistance information form. 
We advise you to save the original packaging. You may need it in 
case to ship the unit to a technical assistance centre. 



 

 Chapter 8 - Appendix - 69 

Privacy Information 

Dear Customer, 
we inform you that your personal data are gathered and will be 
used by Cosmed Srl in conformity with the requirements of the 
Italian privacy law (Decreto Legislativo 196/2003). We believe it 
is important for you to know how we treat your personal data. 

Personal data treatment and purposes 
We request and process your personal data: 
a. to place an order, register a product, request a service, 

answer a survey, enter a contest, correspond with us (all of 
the above, in the following: “service”) and, if necessary, to 
supply the Competent Authorities with the required 
information; 

b. in order to define your commercial profile; 
c. in order to use your commercial profile for own marketing 

and advertising purposes; 
d. for accounting purposes, including e-mailing of commercial 

invoices; 
e. for providing your information to selected business partners 

(also abroad), in order to supply the service; 

How your personal data are treated 
Your personal data will be stored in electronic format, and 
protected at the best from destruction, loss (even accidental), not 
authorized accesses, not allowed treatment or use not in 
conformity with the purposes above listed. 

The consent is optional, but… 
If you deny the consent, we regret we cannot supply the service. 

Holder of the treatment 
The holder of the treatment is Cosmed Srl, Via dei Piani di 
Monte Savello 37, Pavona di Albano Laziale (RM). The 
responsible of the personal data treatment is indicated in the 
documentation stored by Cosmed Srl itself. 
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Customer rights 
In accordance with art.7 of the Law, you can: 
a. obtain confirmation of the existence of your personal data 

and their communication in intelligible form; 
b. obtain: 

• updating, correction or integration of your data; 
• deletion or transformation in anonymous form of your 

personal data; 
c. deny your consent to the treatment of your personal data; 
These rights can be exercised directly requesting in writing to the 
holder of the treatment. 
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ATS 94 recommendations 

Reference: “Standardization of Spirometry: 1994 Update” 
“American J. Respiratory Critical Care Medicine”, Vol. 152, 
1107-1136; 1995. 

ATS recommendations 
Volume range: 8l (BTPS) 
Flow range: ±14 l/sec 
Volume accuracy: ±3% or < 50ml 
Flow accuracy: ±5% or < 200ml/sec 
Flowmeter resistance: <1.5 cmH2O da 0 a 14 l/sec 
Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC 
values should be within 5% or 150 ml. 
The end of test: no change in volume for 1 second with at least 6 
seconds of collected volume. 
Accumulation time: the maximum time allowed for volume 
accumulation during the VC manoeuvre should be at least 30 
seconds and at least 15 seconds during the FVC. 
The spirometer should be store at least 8 FVC maneuvres. 
FEV1 should be calculated by using the “back extrapolation” 
method to detect the start of the test, extrapolated volume must 
not be higher then 5% FVC or 150ml. 
The graphic resolution of the printed report must be as in the 
following: 
Volume: 10 mm/l 
Flow: 5 mm/l/sec 
Time: 20 mm/sec 
F/V ratio: 2:1 
The total number of error (FVC e FEV1 >±3.5%, FEF25-75% 
>5.5%) during the measurement of the 24 standard  waveforms 
must be lower than 4. 
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Predicted values 

ERS93 
Standardized Lung Function Testing: Official Statement of the 
European Respiratory Society, The European Respiratory Journal 
Volume 6, Supplement 16, March 1993. 
Compilation of reference values for lung function measurements 
in children: Ph. H. Quanjer, J. Stocks, G.Polgar, M. Wise, J. 
Karlberg, G. Borsboom; ERJ 1989, 2, Supp.4,184s-261s. 
KNUDSON 83 
Changes in the Normal Maximal Expiratory Flow-Volume Curve 
with Growth and Anging: J. Knudson, D. Lebowitz, J. Holdberg, 
B. Burrows; ARRD 1983; 127:725-734 
ITS 
Intermountain Thoracic Society: Clinical Pulmonary Function 
Testing, second edition (1984) pp 101, 144 
LAM 
A survey of ventilatory capacity in Chinese subjects in Hong 
Kong: Lam Kwok-Kwong, Pang Shing et Al. Annals of Human 
Biology, 1982, vol. 9, No. 5, 459-472. 
Multicéntrico de Barcelona 
Spirometric reference values from a Mediterranean population: J. 
Roca, J. Sanchis, A. Agusti-Vidal, F. Segarra, D. Navajas. R. 
Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur. Physiopathol. 
Respir. 1986, 22, 217-224. 
Nhanes III 
Spirometric reference values from a sample of the general US 
population: John L. Hankinson, John. R. Odencrantz and 
Kathleen B. Fedan. Am J Respir Critr Care Med 1999, 159, 
1798-187. 
Pneumobil (Brazil) 
Valores extraìdos do Programa Pneumobil/Brasil para a Tese de 
Doutoramento do Dr. Carlos Alberto de Castro Pereira. 
(Boehringer). 
Gutierrez (Chile) 
Gutierrez et Al. Reference values for Chile population 
Knudson, Morris and Bass 
The maximal Expiratory Flow-Volume curve: Knudson et al. 
ARRD Vol. 123, p. 659-664, 1981 
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Spirometric Standard for healthy non-smoking adults: ARRD 
Vol. 10-3, p. 57-67, 1971 
Pereira (Brazil) 
Pereira CAC; Barreto SP; Simões JG; Pereira FWL; Gerstler JG; 
Nakatani J. Valores de Referência para Espirometria em uma 
amostra da população brasileira adulta. Jornal de  Pneumologia 
1992; 18: 10-22. 
Mallozi MC. Valores de referência para espirometria em crianças 
e adolescentes, calculados a partir de uma amostra da cidade de 
São Paulo. Valores finais publicados em : Pereira CAC; Lemle 
A; Algranti E; Jansen JM; Valença LM; Nery LE;  Mallozi M; 
Gerbasi M; Dias RM; Zim W. I Consenso Brasileiro sobre 
Espirometria. Jornal de Pneumologia 1996; 22:105-164. 
Scalambrini Costa F, Scueiri CEB, Silva Jr WC, Pereira CAC, 
Nakatani J. Valores de referência para espirometria em uma 
amostra da população brasileira adulta da raça negra. J 
Pneumologia 1996;22: 165-170. 
Neder JA; Andreoni S; Castelo-Filho A; Nery LE. Reference 
values for lung function tests. I. Static Volumes. Brazilian 
Journal Medical and Biological Research 1999; 32:703-17. 
Neder JA, Andreoni S, Lerario MC, Nery LE. Reference values 
for lung function tests. II. Maximal respiratory pressures and 
voluntary ventilation. Braz J Med Biol Res 1999 ;32:719-27 
DLCO 
Standardized Lung Function Testing: Official Statement of the 
European Respiratory Society, The European Respiratory Journal 
Volume 6, Supplement 16, March 1993. 
Compilation of reference values for lung function measurements 
in children: Ph. H. Quanjer, J. Stocks, G.Polgar, M. Wise, J. 
Karlberg, G. Borsboom; ERJ 1989, 2, Supp.4,184s-261s. 
Reference Values for Residual Volume, Functional Residual 
Capacity and Total Lung Capacity - ATS workshop on Lung 
Volume measurements, official statement of the European 
Respiratory Society; J. Stocks, Ph. H. Quanjer: ERJ, 1995, 8, 
492-506 
Single Breath Oxygen Test 
Buist SA, Ross BB: Quantitative Analysis of the Alveolar 
Plateau in the Diagnosis of Early Airway Obstruction. ARRD 
108: 1081, 1973 
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Mansell A, Bryan C, Levison H: Airway Closure in Children. 
JAP 33: 711-714, 1972 
Buist SA, Ross BB: Predicted Values for Closing Volumes Using 
a Modified Single Breath Test. ARRD 107: 744-751, 1973. 
Rint 
Lombardi E, Sly PD, Concutelli G, et al. Reference values of 
interrupter respiratory resistance in healthy preschool white 
children. Thorax 2001; 56: 691-695. 
Mip/Mep 
Leo F. Black, Robert E. Hyatt: Maximal Respiratory Pressures: 
Normal Values and Relationship to Age and Sex, American 
Review of Respiratory Disease, Volume 99, 1969 
Vincken W, Ghezzo H & Cosio MG (1987). Maximal static 
respiratory pressures in adults: normal values and their 
relationship to determinants of respiratory function. Bull Eur 
Physiopathol Resp 23: 435-439. 

Automatic diagnosis (algorithm) 
Reference: “Lung Function Testing: selection of reference 
values and interpretative strategies”, A.R.R.D., 144/ 1991:1202-
1218. 
LLN=Pred-0.674*SD (ATS, 50° percentile) 
LLN=Pred-1.647*SD (ERS, 95° percentile) 
LLN=Pred*0.8  (80%Pred) 

Message interpretation Criterion 

Normal Spirometry FVC and FEV1/FVC > LLN 
Obstructive abnormality 
(it may be physiological) % Pred FEV1 >= 100 
Obstructive abn.: mild % Pred FEV1 < 100 and >= 70 
Obstructive abn.: moderate % Pred FEV1 < 70 and >= 60 
Obstructive abn.: mod. severe % Pred FEV1 < 60 and >= 50 
Obstructive abn.: severe % Pred FEV1 < 50 and >= 34 
Obstructive abn.: very severe % Pred FEV1 < 34 
Restrictive abn.: mild FVC<LLN and %Pred FVC>=70 
Restrictive abn.: moderate % Pred FVC < 70 and >= 60 
Restrictive abn.: mod. severe % Pred FVC < 60 and >= 50 
Restrictive abn.: severe % Pred FVC < 50 and >= 34 
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Restrictive abn.: very severe % Pred FVC < 34 

Quality Control Messages 
Reference: Spirometry in the Lung Health Study: Methods and 
Quality Control, ARRD 1991; 143:1215-1223. 

Message Criterion 

Start faster VEXT >5% of the FVC and >150ml 
Blast out harder PEFT >120 msec 
Avoid coughing 50% drop in the flow in first second 
Blow out longer FET100% <6 sec. 
Blow out more air flow >0.2l/s within 20 ml of FVC 
Blow out harder dPEF<10% 
Take a deeper breath dFVC<200ml and 5% best FVC 
Blow out faster dFEV1<200ml and 5% FEV1 
That was a good test No errors 
FVC reproducible diff. 2 max FVC within 0.2 l 
FEV1 reproducible diff. 2 max FEV1 within 0.2 l 
PEF reproducible diff. 2 max PEF within 10 % 
MVV time too short MVV time less than 12 sec 
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